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1 Introduction
System Description
The Aqua TROLL® sensor is a compact, modular system for measuring
conductivity and temperature in natural groundwater and surface water, as
well as industrial, waste, and other installations. Aqua TROLL 200 sensors
have the added capability of measuring level. Components include
the instrument body, vented and non-vented cables, communication
cables, external power accessories, desiccants, and other installation
accessories, calibration solutions, and software.

How to Use This Manual
This operator’s manual is designed as both a start-up guide and a
permanent reference for Aqua TROLL 100 and 200 instruments.
Section 1: Introduction to the Aqua TROLL Operator’s Manual and
to In-Situ Inc. — Warranty provisions — Instrument repair & return
recommendations
Section 2: System Components — Accessories — Product specifications

Section 1: Introduction
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Section 3: Getting Started — Attaching cable — Installing and launching
the software
Section 4: Using Win-Situ — Connecting for the first time — Customizing
the Home screen — Setting the clock — Setting a device site —
Calibrating conductivity — Preparing to log data — Disconnecting
Section 5: The Conductivity Sensor: Description — Calibration — Available
parameters
Section 6: The Pressure (Level) Sensor: The two basic types of pressure
sensors — Factory and field calibration
Section 7: Field Installation — Guidelines and precautions for long-term
deployment of the Aqua TROLL instrument
Section 8: Connecting for Use with SDI-12, Analog (4-20 mA), and
Modbus Loggers and Controllers
Section 9: Care and Maintenance
Section 10: Troubleshooting
Conventions
Throughout this operator’s manual you will see the following symbols.
The check mark highlights a tip about a convenient feature of the
Aqua TROLL sensor.

The exclamation point calls your attention to a requirement or
important action that should not be overlooked.
Aqua TROLL Operator’s Manual
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Certification
The Aqua TROLL instrument complies with all applicable directives
required by CE and the FCC and found to comply with EN 61326, ICES003, and FCC Part 15 specifications. Declarations of conformity may be
found at end of this manual.
Unpacking and Inspection
Your Aqua TROLL instrument was carefully inspected before shipping.
Check for any physical damage sustained during shipment. Notify In-Situ
and file a claim with the carriers involved if there is any such damage;
do not attempt to operate the instrument. Accessories may be shipped
separately and should also be inspected for physical damage and the
fulfillment of your order.
TIP: Please
save packing
materials for future
storage and shipping of your
Aqua TROLL instrument.
The shipping boxes have
been performance-tested
and provide protection
for the instrument and its
accessories.

Serial Number
The serial number is engraved on the body of the Aqua TROLL. It is also
programmed into the instrument and displayed when the instrument is
connected to a computer running Win-Situ 5 or Win-Situ Mobile. We
recommend that owners keep a separate record of this number. Should
your Aqua TROLL sensor be lost or stolen, the serial number is often
necessary for tracing and recovery, as well as any insurance claims. If
necessary, In-Situ maintains complete records of original owner’s names
and serial numbers.
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To Our Customers . . .
Thank you for your purchase of an In-Situ product. We are glad you chose us and our products
to help you with your environmental monitoring needs. In-Situ Inc. has been designing and
manufacturing world-class environmental monitoring instrumentation for over 25 years in the Rocky
Mountains of the United States. As it was in the beginning, our expectation is that this product will
provide you with many trouble-free years of use. To that end, we pride ourselves on delivering
the best customer service and support possible—24 hours a day, 7 days a week. We believe that
this level of commitment to you, our customer, is imperative in helping you ensure clean, safe
groundwater and surface water resources around the globe. We also understand the need for
accurate, reliable assessments and we continue to make significant investments in Research and
Development to ensure that we deliver the latest product and technological innovations to support
your needs.
Whether you are gathering information about your body of water for a few moments, or over
a period of years, you can rely upon us to provide you with a quality product and outstanding
customer support at a fair price and have that product delivered to you when and where you need it.
We want your experience with In-Situ Inc. to be pleasant and professional, whether you are renting
or purchasing from us. We would be pleased to hear from you and to learn more about your needs
and your experiences with our products. Again, we thank you for choosing In-Situ Inc. and we look
forward to serving your needs now, and in the future.

Bob Blythe, President and CEO
In-Situ Inc.
bblythe@in-situ.com
Aqua TROLL Operator’s Manual
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What We Provide
Warranty Provisions
In-Situ Inc. warrants the Aqua TROLL instruments for one year from date
of purchase by the end user against defects in materials and workmanship
under normal operating conditions. To exercise this warranty contact
Technical Support at the phone or e-mail address listed below for a
return material authorization (RMA) and instructions. Complete warranty
provisions are posted on our website at www.In-Situ.com.
Maintenance & calibration plans as well as extended warranties are
available for U.S. customers. Contact your In-Situ representative for
complete information.
Firmware & Software Upgrades
Aqua TROLL instruments are upgradeable. Contact In-Situ Inc. for details.
How to Contact Us
Technical Support:
800 446 7488
Toll-free 24 hours a day in the U.S. and Canada
Address:
In-Situ Inc.
221 East Lincoln Ave.
Fort Collins, CO 80524
USA
Phone:
970 498 1500
Fax:
970 498 1598
Internet:
www.in-situ.com
e-mail:
support@in-situ.com
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To Obtain Repair Service (U.S.)
If you suspect that your Aqua TROLL is malfunctioning and repair is
required, you can help assure efficient servicing by following these
guidelines:
1. Call or e-mail In-Situ Technical Support (support@in-situ.com). Have
the product model and serial number handy.
2. Be prepared to describe the problem, including how the instrument
was being used and the conditions noted at the time of the
malfunction.
TIP: Please
keep your RMA
number for future
reference.

3. If Tech Support determines that service is needed, they will ask
that your company pre-approve a specified dollar amount for repair
charges. When the pre-approval is received, Tech Support will assign
an RMA (Return Material Authorization) number.
4. Clean the Aqua TROLL instrument and cable. Decontaminate
thoroughly if it has been used in a toxic or hazardous environment.
See the Cleaning Guidelines and form on page 13.
5. Carefully pack your Aqua TROLL instrument in its original shipping
box, if possible. Include a statement certifying that the instrument and
cable have been decontaminated, and any supporting information.
6. Mark the RMA number clearly on the outside of the box.
7. Send the package, shipping prepaid, to
In-Situ Inc.
ATTN: Repairs
221 East Lincoln Ave.
Fort Collins, CO 80524

Aqua TROLL Operator’s Manual
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The warranty does not cover damage during transit. We recommend the
customer insure all shipments. Warranty repairs will be shipped back
prepaid.
Outside the U.S.
If an instrument
returned for
servicing
shows evidence of
having been deployed
in a toxic or hazardous
environment, Customer
Service personnel will
require written proof of
decontamination before
they can service the unit.

Contact your international In-Situ distributor for repair and service
information.
Guidelines for Cleaning Returned Equipment
Please help us protect the health and safety of our employees by cleaning
and decontaminating equipment that has been subjected to any potential
biological or health hazards, and labeling such equipment. Unfortunately,
we cannot service your equipment without such notification. Please
complete and sign the form on page 13 (or a similar statement certifying
that the equipment has been cleaned and decontaminated) and send it
along to us with each downhole instrument.
•

We recommend a good cleaning solution, such as Alconox®, a
glassware cleaning product available from In-Situ (Catalog No.
0029810) and laboratory supply houses.

•

Clean all cabling. Remove all foreign matter.

•

Clean cable connector(s) with a clean, dry cloth. Do not submerge.

•

Clean the probe body—including the nose cone, cable head, and
protective caps. Remove all foreign matter.

If an instrument is returned to our Service Center for repair or recalibration without a
statement that it has been cleaned and decontaminated, or in the opinion of our Service
Representatives presents a potential health or biological hazard, we reserve the right to
withhold service until proper certification has been obtained.
Aqua TROLL Operator’s Manual
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Decontamination & Cleaning Statement
Company Name_____________________________________________Phone_ _______________________
Address________________________________________________________________________________
City_ __________________________________ State_ ________________ Zip_______________________
Instrument Type____________________________________ Serial Number___________________________
Contaminant(s) (if known)__________________________________________________________________
______________________________________________________________________________________
Decontamination procedure(s) used__________________________________________________________
______________________________________________________________________________________
Cleaning verified by_________________________________________ Title___________________________
Date________________________________

Aqua TROLL Operator’s Manual
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2 System Components
Body
There are no
user-serviceable
parts in the Aqua
TROLL body.

The completely sealed Aqua TROLL instrument contains conductivity
and temperature sensors, real-time clock, microprocessor, sealed lithium
battery, data logger, and memory. Aqua TROLL 200 instruments include a
vented or non-vented pressure sensor in a variety of ranges.
Cable
Several basic cable types are used in the Aqua TROLL system.

TIP: Cable
marking VF =
vent-free

•

RuggedCable®, TPU-jacketed (Thermoplastic Polyurethane),
vented or non-vented

•

Vented Tefzel®-jacketed cable (ETFE fluoropolymer)

•

Poly-coated stainless steel suspension wire for deployment of a nonvented instrument
Communication cables for programming the device/downloading the
logged data

•

Section 2: System Components
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RuggedCable® System
Cable includes conductors for power and communication signals,
a strength member, and a Kellems® grip to anchor the Aqua
TROLL instrument securely. Available in standard and custom
lengths.
Uphole and downhole ends are identical “female” bayonet-type
Twist-Lock connectors that mate with the Aqua TROLL body,
cable connect TROLL Com devices, desiccants, and other
accessories.
Vented cable must be used with vented pressure/level sensors
(gauged measurements) on the Aqua TROLL 200. The cable vent
tube ensures that atmospheric pressure is the reference pressure
applied to the sensor diaphragm. Vented cable includes a small
desiccant cap. Large volume desiccants are also available.
Non-vented cable may be used with non-vented pressure/level
sensors (absolute measurements) on the Aqua TROLL 100 or
200 instruments. Vented cable can also be used.

Aqua TROLL Operator’s Manual
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RuggedCable “Stripped & Tinned”

to PLC
or logger

In place of the “uphole” Twist-Lock connector, this cable ends in
bare conductors for wiring to a logger or controller using SDI12, analog (4-20 mA), or Modbus communication protocols.
Vented cable includes an outboard desiccant to protect against
condensation.
to PLC or
logger

Also available in a shorter length ending in a “male”
Twist-Lock connector to mate with RuggedCable.

For connections, refer to wiring diagrams in
Section 8.
to RuggedCable
to Aqua
TROLL

Suspension Wire
Poly-coated stainless steel suspension cable is
ideal for deployment of instruments with non-vented
pressure sensors.

Aqua TROLL Operator’s Manual

to Aqua
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Small Desiccant
Vented cable includes a clear cap of indicating silica
gel desiccant to protect the cable and electronics from
condensation. The desiccant is blue when active. It will absorb
moisture from the top down and for best results should be
replaced before the entire volume turns pink. Replacements are
available from In-Situ Inc. or your distributor.
Large Desiccant
TIP: Protect new
desiccant from
moisture until
ready to use.

The optional high-volume desiccant pack may last up to 20 times
longer than the small desiccant in humid environments. It attaches
to vented Aqua TROLL 200 cable in the same way.
Available with titanium or plastic twist-lock connector.
Refill kits are available from In-Situ Inc. or your
distributor.
Outboard Desiccant
Vented “stripped & tinned” cable includes an outboard
desiccant pack attached to the cable vent tube. Same size as
large desiccant. Replacements and refills are available.
Accessory
Catalog No.
Small desiccant (3)........................................................................ 0052230
Large desiccant, ABS connector................................................... 0053550
Large desiccant, titanium connector.............................................. 0051810
Outboard desiccant (replacement)................................................ 0051380
Refill kit for large & outboard desiccant......................................... 0029140
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Communication Cables
TROLL Coms interface between an Aqua TROLL sensor and a desktop/
laptop PC or handheld PDA for profiling, calibrating, programming, and
downloading. Both include 0.9 m (3 ft) vented polyurethane cable, external
power input jack, and vent with replaceable
membrane.
External
power input
Vent

TROLL Com (Cable Connect)
Connects an Aqua TROLL sensor’s
RuggedCable to a serial or USB port.
Weatherproof, withstands a temporary
immersion (IP67).
The computer
connectors are
not submersible.

RS232
or USB
connector

Twist-Lock
connector

TROLL Com (Direct Connect)
Connects an Aqua TROLL instrument directly to a
serial or USB port. A good choice for permanent
connection to a PC, or for programming a nonvented Aqua TROLL that will be deployed without
RuggedCable. Not submersible or designed for
harsh field conditions.
Accessory
Catalog No.
RS232 TROLL Com, Cable Connect............................................. 0056140
USB TROLL Com, Cable Connect................................................ 0052500
RS232 TROLL Com, Direct Connect............................................. 0056150
USB TROLL Com, Direct Connect................................................ 0052510
Aqua TROLL Operator’s Manual

0061340 rev. 003

Section 2: System Components

19

Power Components
TIP: Win-Situ 5
can display the
approximate
percentage of internal
battery life remaining when
the Aqua TROLL instrument
is connected to a computer.

Internal Power
The Aqua TROLL instrument operates on 3.6 VDC, supplied by a
completely sealed, non-replaceable AA lithium battery. Battery life
depends on sampling speed. The battery is guaranteed for 5 years or
200,000 readings, whichever occurs first.

External Power
External Battery Pack
TIP: When an
Aqua TROLL
sensor is used
as an Analog (4-20 mA),
SDI-12, or Modbus device,
power is supplied by the
data logger or controller
to which the Aqua TROLL
is wired.
Use only In-Situ’s
AC adapter.
Damage to the
Aqua TROLL instrument
caused by the use of
third-party converters is not
covered by the warranty.

The sealed, submersible TROLL Battery Pack (lithium) supplies
14.4 V. When this power source is connected, the Aqua TROLL
instrument will use the external battery source first and switch to
the internal batteries when external battery power is depleted.
Typical external battery life when logging all available parameters
at 2-minute intervals is approximately 2 years.
AC Adapter
In-Situ’s AC adapter provides 24 VDC, 0.75 A, AC input 100-250 V,
includes North American power cord. The Programming Cable includes an
external power input for connection to this adapter.
Accessory
Catalog No.
External Battery Pack.................................................................... 0051450
AC Adapter 24V............................................................................. 0052440

Aqua TROLL Operator’s Manual

0061340 rev. 003

Section 2: System Components

Twist-Lock Hanger

Cable Extender

Locking Wellcap

20

Installation Accessories
• Twist-Lock Hanger: titanium hanger to seal and suspend a nonvented Aqua TROLL instrument while taking data; no venting, no
communication capabilities
• Cable Extender: connects two lengths of RuggedCable
• Wellcaps, locking and vented
• Well Docks: top-of-well support for 2”, 4”, or 6” well
• Panel-mounted bulkhead for connection to RuggedCable
Accessory
Catalog No.
Twist-Lock Hanger, titanium.......................................................... 0051480
Cable Extender.............................................................................. 0051490
Locking Wellcap, 2” ...................................................................... 0020360
Locking Wellcap, 2” vented .......................................................... 0020370
Locking Wellcap, 4” ...................................................................... 0020380
Locking Wellcap, 4” vented .......................................................... 0020390
Top-of-well installation ring........................................ WELLDOCK2”, 4”, 6”
Bulkhead connector....................................................................... 0053240

Well Dock

Bulkhead connector
Aqua TROLL Operator’s Manual
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Control Software
Win-Situ® 5 is easy-to-use software for programming Aqua TROLL
instruments.
Win-Situ provides instrument control for direct reads and profiling,
calibration, long-term data logging, data downloads, data viewing, data
export to popular spreadsheet programs, choice of units and other
display options, battery/memory usage tracking. Win-Situ® Plus enables
configuration of networks and telemetry.
Minimum system requirements: 400 MHz Pentium® II processor; 128 Mb
RAM, 100 Mb free disk space; Internet Explorer® 6.01 or higher; Windows®
2000 Professional SP4 or higher, Windows XP Professional SP2 or higher,
or Windows Vista SP1 or higher; CD-ROM drive; serial or USB port.
Complete information on using the software is available from Win-Situ’s
Help menu.
Win-Situ® Mobile provides the features and functions of Win-Situ 5 on
a field-portable platform. Requirements: In-Situ RuggedReader® with
Microsoft Windows Mobile® operating system (yellow RuggedReader,
Pocket PC 2003 or later; blue RuggedReader, Windows Mobile 5 or later),
serial communications port, and at least 16 Mb for data storage (SD card,
CF card, or the device’s built-in non-volatile memory). For installation
and file exchange, Microsoft® ActiveSync® must be installed on an office
desktop or laptop computer.
Accessory
Catalog No.
Win-Situ 5 (no license required).................................................... 0051980
Win-Situ 5 Plus license.................................................................. 0053560
Win-Situ Mobile license for RuggedReader................................... 0047520
Win-Situ Mobile license (upgrade from Pocket-Situ 4).................. 0047550
Aqua TROLL Operator’s Manual
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Product Specifications
Operating Temperature
Storage Temperature
Dimensions
O.D.
Length
Weight
Material
Housing
Nose Cone
Output Options
Power
Internal Battery
Battery Life
External Power
External Battery
Real-Time Clock
Real-Time Reading Rate
Memory
Max. no. of logs

-20° to +65°C (-4° to +149°F)
-40° to +65°C (-40° to +149°F)
18.3 mm (0.72 in)
31.5 cm (12.4 in)
0.45 kg (1.0 lb)
Titanium
Black Delrin®
RS232 (with TROLL Com), Modbus (RS485), SDI-12, 4-20mA
3.6 V lithium
5 yrs or 200,000 readings* guaranteed
8-36 VDC
14.4 V lithium
Accurate to 1 second per day
1 per second
4 MB, 380,000 data points**
50
Log Type
Fastest Reading Rate Fastest Logging Rate
Linear
1 per minute
1 per minute
Linear Average***
1 per second
1 per minute
Event***
1 per second
1 per second

* 1 reading = time plus all available parameters read from device or logged
** 1 data point = time plus one parameter in a data log
*** External power or external battery pack required for Event logging, recommended for Linear Average logging
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Conductivity
Sensor Type
Material
Range
Accuracy
Resolution
Parameters supported*

Balanced 4-electrode cell
PVC, titanium
5 µS/cm to 100,000 µS/cm
Below 80,000 µS/cm: ± 0.5% of reading plus 1 µS/cm
Above 80,000 µS/cm: ± 1.0% of reading
0.1 µS/cm
Parameter
Actual Conductivity
Specific Conductivity**
Salinity***
TDS
Resistivity
Water Density (based on
salinity)

Units
µS/cm, mS/cm
µS/cm, mS/cm
PSU
ppt, ppm
ohms-cm
g/cm3

Range		
5 – 100,000 µS/cm
5 – 100,000 µS/cm
0 – 42 PSU
0 – 82 ppt
10 – 200,000 ohms-cm
0.98 – 1.14 g/cm3

* Parameters derived from Temperature at 25°C and Actual Conductivity 5 – 100,000 µS/cm
** Derived from Standard Methods 2510B
*** Derived from Practical Salinity Scale 1978 Standard Methods 2520B

For more information on measurement methodology, see the In-Situ technical
note “Aqua TROLL 200 Measurement Methodology” on the In-Situ software/
resource CD, or at www.in-situ.com.

Aqua TROLL Operator’s Manual
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Pressure/Level (Aqua TROLL 200 only)
Sensor Type
Silicon strain gauge
Material
Titanium
Range, Non-Vented
30, 100, 300, 500 psia
Range, Vented
5, 15, 30, 100, 300, 500 psig
Units of measure
Non-Vented
psi, KPa, mm, cm, m, in, ft, Bar, mBar, mm Hg
Vented
psi, KPa, mm, cm, m, in, ft
Accuracy*			
@ 15°
± 0.05% Full Scale (FS)
0° to +50°C
± 0.1% FS
-20 to -1 & +51 to +80°C ± 0.25% FS typical
Resolution
± 0.005% FS or better
Max. pressure
2X range
Burst pressure
3X range
* FS = full scale. Accuracy with 4-20 mA output option: ± 0.25% FS typical

Non-Vented Aqua TROLL 200
Range Effective Range**
Usable Depth
psiapsia kPa
Meters Feet
30
15.5 106.9
0-10.9
0-35.8
100
85.5 589.5
0-60.1 0-197.3
300
285.5 1968 0-200.7 0-658.7
500
485.5 3347 0-341.3
0-1120
** At sea level (14.5 psi atmospheric pressure).

Aqua TROLL Operator’s Manual

Vented Aqua TROLL 200
Range
Usable Depth
psig
kPa
Meters Feet
5
34.5
0-3.5 0-11.5
15 103.4
0-11
0-35
30 206.8
0-21
0-69
100 689.5
0-70
0-231
300
2068 0-210
0-692
500
3447 0-351 0-1153
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Material
Range
Units of measure
Accuracy
Resolution
Cable
Jacket options
Connector
Conductors
Diameter
Break strength
Minimum bend radius
(vented cable)
Weight

Suspension Wire
Material
Coating
Weight
Overall O.D.
Break strength

25

Titanium
-20° to +65°C (-4° to +149°F)
Celsius, Fahrenheit
± 0.1°C
0.01°C

Polyurethane, Tefzel®
Titanium, 18.5 mm (0.73 in) O.D.
6 conductors, 24 AWG, polypropylene insulation
6.7 mm (0.265 in)
127 kg (280 lb)
2X cable diameter (13.5 mm, 0.54 in)
Vented, regular: 14 kg/300 m (32 lb/1000 ft)
Non-vented, regular: 16 kg/300 m (35.6 lb/1000 ft)
Vented Tefzel: 14 kg/300 m (32 lb/1000 ft)
304 stainless steel, 7 x 7 strand
15 mil polyester elastomer insulation
0.28 kg/30 m (0.60 lb/100 ft)
2.2 mm (approx. 1/16 in)
122 kg (270 lb) with proper tightening of clips
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3 Getting Started
This section provides a quick overview of the initial steps necessary to get
the instrument ready to communicate:

4 Select the appropriate TROLL Com for communication. This
determines the hardware connections, and may influence the software
installation. The drawing on the following page shows the function of
the different TROLL Com models.

4 Install the software.
4 Connect the hardware, based on the selected TROLL Com.
4 Launch the software and establish communication with the Aqua
TROLL. See Section 4 of this manual for an overview of Win-Situ
operations.
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Select a TROLL Com for Communication
The figure below shows the function and connectability of the different
models of TROLL Com.
USB port

Serial port
TIPS: A Direct
Connect TROLL
Com may be
preferred for programming
an Aqua TROLL that will be
deployed on wire.

RS232
connections

RuggedCable and a Cable
Connect TROLL Com are
required for communication
with the device while
deployed, but programming
can be done with any
TROLL Com connection.

USB
connections

Direct Connect
TROLL Coms:
Not designed
for submersion

An RS232 (serial) TROLL
Com is needed for use with
a RuggedReader.

Cable Connect TROLL Coms:
Designed for field use
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Install the Software
Install Win-Situ 5 from the In-Situ software/resource CD or from the In-Situ
website:
TIP: If using a
USB TROLL
Com, be sure
to select the option “Install
USB TROLL Com Drivers”
when installing Win-Situ 5.

•

Click on Win-Situ 5, and follow the instructions to install Win-Situ 5 to
your local hard drive.

USB TROLL Com Drivers
•

If using a USB TROLL Com, be sure to select the option "Install USB
TROLL Com Drivers." Two drivers will be loaded to your hard drive,
one for the USB TROLL Com, one for the USB TROLL Com serial
port.

Win-Situ Mobile

TIP: Insure
Microsoft
ActiveSync is
installed on the desktop
or laptop PC and a Guest
connection or partnership
has been established
between the computers.

For communication using a RuggedReader handheld PC in the field,
install the desktop component of Win-Situ Mobile on a desktop/laptop
PC from the CD or website: The desktop component is called the WinSitu Software Manager, and is needed to install Win-Situ Mobile on the
RuggedReader.
1. Click on Win-Situ Mobile and follow the instructions to install the WinSitu Software Manager to your local hard drive.
2. Connect the RuggedReader to the desktop computer, establish a
connection in Microsoft ActiveSync®, launch the Win-Situ Software
Manager, and follow the instructions to install Win-Situ Mobile on the
RuggedReader.
Win-Situ Sync
If you plan to synchronize log files from the RuggedReader to a PC after
collecting data in the field, install Win-Situ Sync from the CD or website.
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Connect the Hardware
TIP: If you need
more information
on the Twist-Lock
connectors, refer to the
topic Twist-Lock Cable
Connections later in this
section.

1. Connect the Aqua TROLL sensor to the selected TROLL Com as
illustrated earlier in this section.
•
•

Direct Connect: Attach via push-on connection to the Aqua TROLL
back end.
Cable Connect: Mate the Twist-Lock connectors on the Aqua
TROLL and the RuggedCable.

2. Plug the TROLL Com into the computer.
USB TROLL Com
When you plug in a USB TROLL Com, the USB drivers that were
downloaded when you installed Win-Situ 5 will be installed as follows:
•
•
Remember
the COM port
number. You will
need it when connecting
to the Aqua TROLL in
Win-Situ.

Windows 2000, Windows Vista: When new hardware is detected,
the drivers are installed automatically.
Windows XP: Follow the instructions in the Found New Hardware
Wizard. Select the option “Install Software Automatically.”

After installation, check as follows to find which COM port the connected
USB TROLL Com is using:
•
•

Windows 2000, Windows XP: Control Panel > System > Hardware
tab > Device Manager > Ports. Click the plus sign to display the ports.
Windows Vista: Control Panel > System > Device Manager
(Administrator permission required) > Ports. Click the plus sign to
display the ports.

After connections are made, you are ready to launch the software and
program the Aqua TROLL instrument. Section 4 of this manual is an
overview of Win-Situ. For more detailed information, see Win-Situ’s Help
menu.
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Twist-Lock Cable Connections
1. Remove the protective caps from the Aqua TROLL connector end and
cable connector end.
TIP: Retain the
dust caps to
protect the pins
and o-ring from damage
when cable is not attached.

Aqua TROLL
(or Cable Connect TROLL Com)
Flat

Cable

Flat

Aqua TROLL
(or Cable Connect
TROLL Com)

Cable

2. Take a moment to look at the connectors. Each has a flat side.
Note the pins on the body connector (one on each side) and the slots
on the cable connector (one on each side).
pin
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3. Slide back the sleeve on the cable connector.

4. Orient the “flats” so they will mate up, and insert the Aqua TROLL
connector firmly into the cable connector.

Aqua TROLL

Cable

5. Slide the sleeve on the cable toward the Aqua TROLL body until
the pin on the body pops into the round hole in the slot on the cable
connector.
6. Grasp the knurled (textured) section of the cable connector in one
hand and the Aqua TROLL body in the other. Push and twist firmly so

Aqua TROLL
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that the pin on the body connector slides along the slot on the cable
connector and locks securely into the other hole.

Be sure you
hear the “click.”
The “click”
ensures the cable is
securely attached.

To attach a Cable Connect TROLL Com, first remove the desiccant from
the cable by grasping the knurled (textured) section of the cable connector

Aqua TROLL

Cable

in one hand and the desiccant in the other. Twist in opposite directions to
unlock the desiccant from the cable.
Orient the “flats” so they will mate up, and insert the TROLL Com
connector firmly into the cable connector.

Push, twist, and click to lock.
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4 Using Win-Situ
Win-Situ® 5 is the In-Situ instrument control software for Aqua TROLLs.
Use Win-Situ to:

TIP: Win-Situ
Mobile provides
Win-Situ 5
features and functionality
in a convenient field-worthy
platform.

•

Display real-time readings from the connected Aqua TROLL, in
meter, tabular, or graphic format

•

Program the device to log data; download the logged data

•

Calibrate the conductivity sensor, select output parameters and
units

•

Customize the output of a pressure/level sensor to record
drawdown, surface water elevation, gauge height, stage height, etc.

•

Set communication options in the device—Modbus, SDI-12, analog,
IP, telemetry, etc.

Launch the Software and Connect to the Aqua
TROLL
1. Start Win-Situ by double-clicking the shortcut
desktop during installation.

created on the
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Win-Situ launches and displays the Data area (“Data tab”), shown
below.
TIP: For direct
serial connection
the port is usually
COM 1. This is the Win-Situ
default.
For USB communication,
be sure to select the correct
COM port.

2. Check the COM port. When you launch for the first time, the software
may ask if you want to select a COM port. Do one of the following:
 Answer Yes to the prompt, then check or change the port in the
to close it, or

Comm Settings dialog, and click OK
 Answer No to bypass this step.

3. Win-Situ asks if you want to connect to the Aqua TROLL (the
“device”). If the Aqua TROLL instrument is connected to your
computer as described in the previous section, answer Yes.

TIP: You can turn
off the “Connect
now?” prompt:
Select Prefrences menu >
General Settings, deselect
“Prompt for connect at
startup,” click OK. In this
case, connect to the device
by clicking the Connect
button
.

C:\Documents and Settings\ [Login] \My Documents\WinSitu Data

Data tab
2

3

Connect
button
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4. Software connects and displays a reading of all supported parameters.
Tabs
Dashboard

Home tab

Click here to update
readings in real time

Device is connected

Control Panel

The Home Screen
 Note the Tabs at the top of the screen—this is the Home tab, which
displays current readings from the connected device.
 The Dashboard (status area) shows the device model & serial
number, battery and memory usage, clock, alarms, and logging status.
 The Control Panel contains action buttons. To update the readings in
real time, press

.

Note: When this button looks “pressed in”
, polling is active.
Before you can perform certain software tasks, you will need to stop
polling by pressing the button again.
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Customizing the Home Screen Display
Changing Units
1. Click the Sensors tab , select the sensor whose unit you wish to
change.
TIP: Unit
selection is not
available if the
device is polling or has an
active log.

2. Click the “Configure” button
the control panel.

in

3. In the Sensor Setup screen, select a
parameter, then select a unit. Repeat for
each parameter as necessary.
4. Click OK
Sensors tab.

to return to the

Changing the Rate at Which the Readings Update
Also called the “poll rate,” this can range from 1 to 30 seconds.
1. Select Preferences menu > Home View Settings.
2. Adjust the Poll Rate. Default: 5 seconds.
Changing the Decimal Places Displayed
TIP: All
parameters
supported by
the device are
shown in the Home screen
by default. To change this,
select Preferences menu
> Home View Settings.
Deselect any parameters
you do not wish to view by
clearing the check boxes.

To change the number of decimal places displayed for each reading:
1. Select Preferences menu > General Settings.
2. Under Parameter Defaults, select a parameter, then the “significant
decimal digits” for each parameter.
Real-Time Graphing
To view a real-time trend graph: click the “Graph” button
To view a graph with a data table below it, select Preferences menu >
Graph Settings. Check  the Data Panel option. Click OK.
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Preferences
option on the
Menu bar
allows users to configure
instrument software,
including:
• General settings
• Comm settings
• Working directory
• Graph settings
• Home view settings
• Data view settings
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Now you’re ready to set specific information in the software. Win-Situ
provides many options. At a minimum:
• Set the Aqua TROLL clock
• Enter a name for the site where the instrument will collect data
• Calibrate the conductivity sensor
• Enter data logging instructions
A brief overview is provided here. For more detailed information, see the
Win-Situ Help menu.
Set the Clock
Data collection schedules depend on the device’s real-time clock. Both the
device clock and the system (PC) clock are shown on the dashboard. The
clocks update every 2 seconds. If the device clock differs by more than
2 seconds from the system clock, the device clock is displayed in red. To
synchronize the clocks, click the “Sync” button .

Clock Sync
button
Device clock
PC clock
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Add a Site

TIP: A default site
is supplied and
may be used, but it
does not contain any
specific information on the
location data collection site.
For more information on
sites, see Win-Situ Help
menu.

Logged data are organized and filed by the site where the data were
logged. This feature can help you manage data from multiple sites. You
can create as many sites as you like, with or without an Aqua TROLL
connected. Sites are stored in the site database in your Win-Situ working
directory and are available to select for any Aqua TROLL, any log.
You will need a site when setting up a data log. Here are the steps to set
up a new site:
1. On the Data tab, click the Site Data folder.
2. Select File menu > New > Site.

TIP: You can also
create a Site
Group to organize
multiple sites within a Site
Group folder.

Aqua TROLL Operator’s Manual
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3. In the Site Information screen, enter a name for the site. A short,
descriptive name is best—for example, a project, well, water body,
gauging station, town, nearby landmark, etc. Length is limited to 32
characters.
TIP: Site
coordinates are
optional. They are
also used to establish the
probe location for dynamic
specific gravity calculation, if
used. See the Win-Situ Help
menu, or Section 6 below.

A site name is the only required field, but there are many additional
options for identifying a site. To include site Coordinates, check
 Coordinates, then enter Latitude (0.00 to 90.00, select North
or South from listbox), Longitude (0.00 to 180.00, select East or
West) and Elevation (select Feet or Meters). You can add a short
descriptive Note, import a site Photo (bitmap), and/or specify a custom
Connection. (If any connections have been defined, they will be
displayed.)
4. When finished, click Save to save the site.

Name the site

Save the site
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The new site will appear in the Site Data folder, and Win-Situ will add
it to the site database in the working directory on your computer. It is
now available to select for any device, any log.

New site
appears in Site
Data folder
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5. To set this new site in the connected Aqua TROLL instrument: Return
to the Home tab, click the down arrow beside the site box, and select
your new site.
This site now becomes the “current” site for the connected Aqua
TROLL sensor, and is available to use in data logs.

Select the site
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Check the Conductivity Calibration
The conductivity sensor in the Aqua TROLL instrument has been
calibrated during manufacturing to produce a flat response across
the operating range.
We recommend you check the specific conductivity reading in
the solution shipped with your instrument. If the device is reading
accurately, there is no need to field-calibrate the instrument unless
SOPs require it.
For best results
we recommend
you read and
follow the conductivity
calibration procedure in
Section 5 of this operator’s
manual.

To perform a field calibration you will need:
 The In-Situ Cal Cup, or other suitable container that allows for
complete immersion of the conductivity sensor, including the
temperature “button,” which can be seen on one
Temperature
side of the probe. The Cal Cup is recommended
Conductivity
for the first calibration.
 The calibration standard solution supplied, or
other solution of known specific conductivity in
the range 100 to 60,000 µS/cm.

Pressure

The complete calibration procedure takes only a few minutes and may be
done in a field or office/lab setting with a software connection in Win-Situ
5 or Win-Situ Mobile. A detailed description of the conductivity calibration
procedure, including:
• Preparation of the Aqua TROLL instrument
• Software input
• Calculated output
• Hints for successful calibration
is in Section 5 of this manual.
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Prepare to Log Data
1. To program the device to log data, go to the Logging tab.
2. Click the “New” button.
TIP: Be sure to
stop “Polling” in
the Home screen
before setting up a data log.

Logging tab
“New” button

TIP: For more
complete
information on
setting up data logs, see the
Win-Situ Help menu.

The Logging Setup Wizard will guide you through the configuration of a
data log—including the site, log name, parameters to measure, sample
schedule, start time, stop time, level output, and other options.
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Tips for Aqua TROLL Data Logs
•

Nine parameters are available for the Aqua TROLL 200. Seven
parameters are available for the Aqua TROLL 100. All selected
parameters are logged, with implications for battery and memory
usage.

•

Only one “active” log can reside in the device at a time. An “active” log
is a log that is Ready, Pending, Running, or Suspended as shown in
the Status column of the Logging Tab.

•

To avoid draining the Aqua TROLL battery prematurely, external power
is required for Event logging, and recommended for Linear Average
logging.

•

For information on selecting a Level output, refer to the Win-Situ Help
menu, or Section 6 in this manual.

•

For a non-vented Aqua TROLL that will be deployed on wire, be sure
to select a Scheduled Start so the log will start by itself, without a
communication connection.

•

For more complete information on setting up data logs, see the WinSitu Help menu .

Aqua TROLL Operator’s Manual

0061340 rev. 003

Section 4: Using Win-Situ

TIP: As an
alternative to
the log control
buttons, right-click a log
to display a short context
menu of available actions.

TIP: The
available log
control buttons
will vary depending on the
status of the selected log.
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To Start logging:
•
•

A “Pending” (scheduled) log will start at its programmed time.
You can start a “Ready” (manual) log at any time
.
while connected by selecting the log and pressing “Start”

To Stop logging:
•
•

Select the log and press the “Stop” button
.
Or suspend (temporarily stop) it with the “Pause” button

.

To Download the log to the connected PC:
•

Select the log and press the “Download” button

.

To View the log after downloading:
•

Go to the Data tab and select the log; for a graph press

.

“Start” button
Logging tab

“Ready” log

Log control buttons
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Disconnect
After the Aqua TROLL is programmed to log data, you are ready to:
Be sure to
remove the
desiccant dust
cap (if present) before
deployment to allow air to
reach the cable’s vent tube.

•

Exit the software (File menu > Exit).

•

Disconnect the TROLL Com from the cable connector, by grasping
the knurled (textured) section of the cable connector in one hand and
the TROLL Com in the other. Twist in opposite directions to unlock the
TROLL Com from the cable.

•

Vented cable: Attach desiccant to the cable connector—line up the flat
sides of the connectors, push, twist, and click to lock the desiccant to
the cable. Remove red dust cap (if present) from the desiccant’s vent.

•

Non-vented Aqua TROLL (or installations where vented pressure or
communication are not required): Attach a non-vented cable or TwistLock hanger and suspension wire.

•

Install the instrument in its field location. See Section 7 for guidelines.
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5 Conductivity
About Conductivity
Conductivity measures the ability of a material to carry an electric current.
Generally, the higher the concentration of dissolved salts and minerals in
water, the better the conductor and the higher the electrical conductivity.
Deionized/distilled water is a poor conductor because almost all anions
and cations are removed during the deionization/distillation process.
If conductivity changes in a body of water, it often indicates an
environmental event. For example, a dramatic increase in the electrical
conductivity of an underground fresh water aquifer located near the ocean
could indicate the beginning of saltwater intrusion. On the other hand, an
increase in the electrical conductivity of a small lake that is completely
surrounded by farmland may simply be the result of runoff from recent
precipitation.
How is Conductivity Measured?
Conductance is the reciprocal of the resistance, in ohms, measured
between two opposing electrodes of a 1 cm cube at a specific
temperature. The unit 1/ohm or mho was given the name of Siemens
(S) for conductance. It is not practical to require all conductance cells
to have the dimensions of an exact cube. To enable the comparison of
data from experiments with different conductance cells, the conductance
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is multiplied by the cell constant to give conductivity in Siemens per
centimeter (S/cm). Cell constants are determined for each sensor using
a standard solution of known conductivity. The cell constant depends on
the electrode area and the amount of separation or distance between the
electrodes.
The modern four-electrode conductivity cell contains two drive electrodes
and two sensing electrodes. In the Aqua TROLL instrument, each drive
electrode is composed of two interconnected pins, for a total of six pins.
The sensing electrodes are positioned in a low current area to minimize
electrode fouling. An alternating current is used to drive the cell. This
reduces errors caused by polarization resulting from the application of a
direct current.
Calibration
TIP: For more
information
on factory
calibration of the
conductivity sensor, see
the technical note “Aqua
TROLL 200 Conductivity
Accuracy” on the In-Situ
software/resource CD, or at
www.in-situ.com.
TIP: When
calibrating
below 1,000 µS/
cm, additional care must
be taken to prevent the
calibration solution from
drifting due to atmospheric
exposure.

The conductivity sensor in the Aqua TROLL instrument has been
calibrated during manufacturing to produce a flat response across
the operating range. Standard Operating Procedures for measuring
conductivity in the field typically specify that the sensor shall be calibrated
before use, close to the expected temperature and conductivity conditions.
The accuracy of the sensor depends on the calibration solution used and
the operator’s technique.
We recommend that you check the specific conductivity reading in the
solution shipped with your instrument. If the device is reading accurately,
there is no need to field-calibrate the instrument unless SOPs require it.
The Aqua TROLL instrument can be calibrated at any point in the
operating range. However, best results will be obtained in the range of
approximately 100 to 60,000 microSiemens/cm (µS/cm).

Aqua TROLL Operator’s Manual

0061340 rev. 003

Section 5: Conductivity

49

When carbon dioxide from the air dissolves into water it increases the
conductivity, sometimes by as much as one or two µS/cm. This could
shift a 146.9 standard by as much as 3%. The amount of shift is not
predictable, so it should be minimized by limiting the amount of exposure
to air. Fill at least to the marked fill line and close the cup as soon as
possible. A small air bubble in the cup is acceptable, and in fact it assists
mixing during the inversions. Discard remaining portions of low range
calibration standards within a few days after opening the bottle.
To perform a conductivity calibration of the Aqua TROLL instrument you
will need:
 The In-Situ Cal Cup supplied with your instrument
 The calibration standard solution supplied, or other other solution of
known specific conductivity in the range 100 to 60,000 µS/cm.
Preparing to Calibrate
Three factors are essential to a successful conductivity calibration:
A The calibration solution is not diluted or contaminated.
B The probe and the solution are at the same temperature.
C The sensing cell is completely filled with solution—no air bubbles
on the sensor.
The following preparation steps can help to insure a successful
calibration and avoid erroneous field data.
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A Eliminate water and rinse
1. Remove the nose cone (Aqua TROLL 200 only). Water trapped here can
dilute the calibration solution. Air bubbles may also come from this area.
2. If the device is wet from previous use, dry the body and shake to clear
any liquid inside the conductivity sensor.
When the
nose cone
is removed,
the pressure sensor
diaphragm is exposed. Do
not touch the face of the
pressure sensor!

3. Before opening the solution bottle, invert it a few times to redistribute
any water condensation.
4. Remove the Cal Cup cap and fill the cup to the “Rinse” line with
calibration solution.
5. Insert the Aqua TROLL through the grommet in the cap.
6. Attach the cap to the Cal Cup. The Aqua TROLL should
rest on or near the bottom.
7. Shake vigorously to rinse the sensing cell.

Cap

8. Loosen the cap, remove the Aqua TROLL (no need to pull
it out of the cap), and discard the solution.

Fill

9. For best results, rinse again using the same procedure.

Rinse

B Equalize temperature

Grommet

Cal Cup
TIP: A second
rinse is important
if the Cal Cup and
the Aqua TROLL were not
clean and dry at the start of
this process.

1. Fill the Cal Cup to the “Fill” line with calibration solution.
2. Install the Aqua TROLL and tighten the cap.
3. Invert multiple times for at least 30 seconds—longer if the
probe and solution are at different temperatures.
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C Dispel air bubbles from the sensor
1. Hold the Aqua TROLL horizontally, and firmly
tap the Cal Cup against a convenient surface
(for example, your other hand).
2. Rotate the Aqua TROLL on its axis about 45
degrees and tap again.
3. Rotate another quarter turn and tap again.
Note: Sometimes dissolved gases in the solution
will cause bubbles to form on the sensor, especially if the solution was
cold. Thermal equilibrium may require extra time, and air bubbles may

Tap
TIP: With the
correct fill level,
and the instrument
held at a 45° angle, the air
bubble in the Cal Cup will
not intrude into the
conductivity sensor.

need to be tapped off before starting the calibration. If you can see

Rotate and Tap

bubbles on the inside of the Cal Cup, bubbles are probably on the sensor.
Calibration Procedure
TIP: For best
results when
calibrating a
completely dry sensor,
allow it to soak for 15
minutes in the calibration
solution before proceeding.

1. If you have not already done so, attach cable to the Aqua TROLL and
to the computer, launch Win-Situ, and connect to the device.
2. Go to the Sensors tab and select the sensor.
3. Click the “Calibrate” button
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4. In the next screen, select the Conductivity parameter and click
Calibrate...

Sensors tab

2 Select the sensor
3 Click “Calibrate”
4 Select Conductivity,
click Calibrate...

TIP: The probe
can be in a
horizontal or
vertical position during
calibration.
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After a review of the preparation steps just performed, a screen like
this appears:

TIP: The Write
Defaults button
restores the
factory cell constant to the
sensor.

5. Enter the Specific Conductivity of the calibration solution in µS/cm.
Click Accept.
6. Click Start Calibration.
TIP: “Delta” is
the change in
sensor response
between the last two
readings. This enables you
to follow the progress of the
stabilization, but deviation
from the previous reading
is not necessarily the best
indicator of stability as
the software is looking at
longer-term trends.

Software will monitor the conductivity and temperature readings,
calculate the cell constant (sometimes called the “Kcell”), and inform
you when the response meets the criteria for Nominal Stability.
7. You can click Accept... at any time to continue. For best results, wait
until Full Stability is reached. At that time, the next screen is displayed
automatically.
8. Look at the Proposed Cell Constant before you Commit it to the
sensor. It should be in the range 0.98 to 1.02.
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(continued)

TIP: If the
proposed cell
constant is
outside the range 0.98
– 1.02, check conditions
and repeat the calibration.

TIP: A change
from an earlier
cell constant of
0.02 suggests that the
calibration should probably
be repeated. Check
conditions and re-do the
calibration.
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If the cell constant is suspect, the
cause could be an air bubble,
incomplete rinsing, sensor
fouling, or other factors. Repeat
the preparation and calibration
with fresh cal solution.
9. When you are satisfied with the
proposed cell constant, click
Commit to write the calculated
cell constant to the sensor.
10. If the Aqua TROLL will be
deployed immediately, remove it
from the Cal Cup, rinse it, discard the calibration solution, and reinstall
the black nose cone. Otherwise, store it wet in the Cap Cup (in cal
solution or water) for later deployment.
Available Parameters
The Aqua TROLL instrument can also calculate and record derived
parameters as listed below.
For more information on measurement methodology, including the
equations used to derive the calculated parameters, see the technical note
Nominal Stability vs. Full Stability
To meet the criteria for a valid calibration point, the change (Delta) in sensor
response is monitored over time. The software is looking for the calibration
solution temperature and the sensor readings to settle over a specific time
period. The criteria for Full Stability are designed to meet the published
specifications. The criteria for Nominal Stability are designed to shorten the
calibration time when an approximate calibration is acceptable.
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“Aqua TROLL 200 Measurement Methodology” on the In-Situ software/
resource CD, or in the Downloads section of the In-Situ web site at www.
In-Situ.com.
Actual Conductivity
Units:

microSiemens per centimeter (µS/cm), default
milliSiemens per centimeter (mS/cm)

Specific Conductivity
A means of expressing what the actual conductivity of a solution would
be at a standard reference temperature (25°C). Calculated from actual
conductivity and temperature. The factory default coefficients calculate
specific conductivity per Standard Methods 2510B.
Units:

microSiemens per centimeter (µS/cm), default
milliSiemens per centimeter (mS/cm)

Salinity
Calculated from actual conductivity and temperature. Units: Practical
Salinity Units (PSU)
Total Dissolved Solids (TDS)
Calculated from specific conductivity using a conversion factor (Default: 0.65).
The TDS conversion factor may be edited in Win-Situ as follows: Select
, in the next
the sensor on the Sensors tab, click Configure
screen select the Total Dissolved Solids parameter and click Configure...
Enter a value between 0.001 and 10.000.
Units:
Aqua TROLL Operator’s Manual
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Resistivity
The reciprocal (inverse) of the actual conductivity. Useful when monitoring
pure water. Units: ohms-cm
TIP: Parameter
configuration is
not available if the
device is polling or has an
active log.

Density of Water
Calculated from salinity and temperature. Units: g/cm3
Shallow Deployment
When deploying the Aqua TROLL instrument in shallow water, bubble
formation on the conductivity sensor can create false readings. We
recommend the following to minimize the formation of bubbles:

TIP: Measured
density values
may be used
to dynamically compute
specific gravity when
measuring Level. See
Win-Situ Help or Section
6 of this manual for more
information.

 Surface water: Gently agitate the instrument. Natural water flow will
help to prevent bubbles.
 Groundwater well or any location without flowing water, or where the
instrument cannot be seen:
1. Lower the Aqua TROLL until it is below the surface of the water.
(Tip: This can be determined if not visible by monitoring the
pressure/depth readings.)
2. Allow the conductivity sensor to be thoroughly wetted (at least 30
seconds).
3. Briskly agitate up and down several times, while not taking the
device above the water surface.
4. When the conductivity readings stabilize, the Aqua TROLL is ready
for deployment.
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Maintenance and Recalibration
The need to clean the sensor is determined by the site conditions, and
the accuracy you wish to achieve from the instrument. For example, when
used in relatively clean water of low biological productivity, a conductivity
sensor could maintain its accuracy specifications for several months.
On the other hand, in water with a high potential for biological or mineral
fouling, the sensor may need to be cleaned and recalibrated more often.
Visual inspection and measurement results are the best indicators that a
device needs service recalibration.
It is the user’s responsibility to develop and follow a maintenance program
appropriate to the site. Most SOPs instruct that the instrument be checked
in a known standard at the end of a deployment. After any cleaning
that is performed, the calibration should always be checked before
redeployment, and the sensor recalibrated when necessary.
For specific cleaning procedures, refer to the Care and Maintenance
recommendations in Section 9.
Factory recalibration of the Aqua TROLL 200 should be performed every
12-18 months. Contact In-Situ Inc. as described on page 10.
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6 Pressure and Level
The Aqua TROLL 200 contains a pressure sensor. A pressure transducer
senses changes in pressure, measured in force per square unit of surface
area, exerted by water or other fluid on an internal media-isolated strain
gauge. Common measurement units are pounds per square inch (psi) or
newtons per square meter (pascals).
Non-Vented (Absolute) vs. Vented (Gauged)
Sensors
A non-vented or “absolute” pressure sensor measures all pressure forces
exerted on the strain gauge, including atmospheric pressure. Its units are
psia (pounds per square inch “absolute”), measured with respect to zero
pressure.
Non-vented pressure measurements are useful in vacuum testing, in
short-term testing when atmospheric pressure would not be expected
to change, in very deep aquifers where the effects of atmospheric
pressure are negligible, and in unconfined aquifers that are open to the
atmosphere.
With vented or “gauged” pressure sensors, a vent tube in the cable
applies atmospheric pressure to the back of the strain gauge. The basic
unit for vented measurements is psig (pounds per square inch “gauge”),
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measured with respect to atmospheric pressure. Vented sensors thus
exclude the atmospheric or barometric pressure component.
This difference between absolute and gauged measurements may be
represented by a simple equation:
TIP: For more on
the differences
between Absolute
(non-vented) and Gauged
(vented) sensors, see
the technical note on the
In-Situ software/resource
CD, or www.in-situ.com.

Pgauge = Pabsolute – Patmosphere
Pressure, Depth, and Level
Output options for pressure measurement are completely softwareselectable. Each log configuration presents the following choices:
•
•
•

Pressure in psi or kPa
Depth in feet or meters
Water Level with a reference (an “offset”)
 Surface Elevation: positive up
 Depth to Water (drawdown): positive down

For Depth and Level, the software presents additional options:
•
•
•

The type of measurement you wish to log (the “output”)
The Level Reference you wish to use
The specific gravity of the water the device will be deployed in:
 Choose a fixed value for fresh, brackish, or saline water, or
 Enter a custom specific gravity value, or
 Choose Fixed density with gravitational compensation for a
pressure-to-level conversion that compensates pressure readings
for fluid density and local gravitational factor (based on your latitude
and elevation), or
 Choose Dynamic density with gravitational compensation, which
will allow the software to dynamically compute specific gravity
using density measured by the Aqua TROLL’s conductivity sensor
and local gravitational factor
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Configuring Depth and Level
TIP: When
you configure
level using the
Sensors tab, the settings
are stored in the Aqua
TROLL and are available
for use in Modbus,
SDI-12, and analog
communications, as well
as in Win-Situ. Different
configurations may be
selected when setting up
a log.

This procedure stores the configuration settings in the Aqua TROLL.
When setting up a log, the same options are presented.
1. While connected to the Aqua TROLL in software, click the Sensors
tab.
2. Select the sensor and click the “Configure” button

.

Sensors tab

Select the sensor

TIP: Be sure to
stop “polling” in
the Home screen
before configuring any
sensor parameter.

“Configure” button
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3. In the Sensor Setup window, select the Level parameter, then click
Configure...
The Level parameter shown is the one currently stored in the device
(device’s default or the most recent choice). You will have a chance to
change this in a moment.
TIP: Parameter
configuration is
not available if the
device is polling or has an
active log.

Select the
Level
parameter
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4. In the Level Setup Wizard, select the options you want. Each choice
includes an illustration to assist you in selecting the output. For more
information, see Win-Situ’s On-Line Help.
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Pressure Sensor Calibration
Factory Recalibration

TIP: In a Level
mode, any zero
pressure offset
is corrected automatically.
The field recalibration
procedure is not necessary
except when measuring
pressure.

Pressure sensor accuracy can be adversely affected by improper care
and handling, lightning strikes and similar surges, exceeding operating
temperature and pressure limits, physical damage or abuse, as well as
normal drift in the device’s electronic components. Aside from damage
to the sensor, the need for factory recalibration is dependent upon the
amount of drift a customer is willing to tolerate. Factory calibration every
12-18 months is recommended. Contact In-Situ Customer Service for
information on the factory maintenance and calibration plan.
Field Recalibration
The following procedure may be used, with caution, to “zero” the offset of
a vented pressure sensor to correct for electronic drift. The drifted offset is
visible when the sensor is in air and reading other than zero.
It is recommended you do not zero the offset if it is outside the specified
accuracy of your pressure sensor, as shown in the table below. If the
reading in air deviates from zero by more than the amounts shown, you
may want to consider a factory recalibration.
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Sensor
range

Accuracy
(0°C to +50°C)

5 psi
15 psi
30 psi
100 psi
300 psi
500 psi

± 0.1% FS
± 0.1% FS
± 0.1% FS
± 0.1% FS
± 0.1% FS
± 0.1% FS

Acceptable Offset
from zero
± 0.005 psi
± 0.015 psi
± 0.03 psi
± 0.10 psi
± 0.30 psi
± 0.50 psi
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Field Recalibration Procedure
1. With the Aqua TROLL connected in software, go to the Sensors tab.
2. Select the pressure sensor and click the “Calibrate” button

.

3. In the next screen, select the Pressure parameter and click
Calibrate...
4. In the next screen, select Zero the Level/Pressure sensor. Make
sure the device is dry and exposed to air.
5. Click OK
. The software will inform you when the pressure
reading is set to zero.
Sensors tab

2 Select the sensor,
click “Calibrate”
3 Select Pressure,
click Calibrate...
4 Select Zero the sensor

5 Click OK
Aqua TROLL Operator’s Manual
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Barometric Compensation of Non-Vented
Pressure/Level Data
Win-Situ Baro Merge™ software can post-correct absolute (nonvented) level sensor data to eliminate barometric pressure from the
measurements. Baro Merge provides three options:
•

Fixed Correction – A single offset value is applied to all selected log
data. Use this option if you know what the barometric pressure was
during the log, and know that it did not change.

•

Manual Entry – Specify two or more correction values to apply to
the log data. Use this option if you know that barometric pressure
changed during the log.

•

BaroTROLL® log file – Absolute level sensor data are corrected
by barometric pressure values logged by an In-Situ BaroTROLL
instrument during the same general time period

Launching Baro Merge Software
Baro Merge may be launched as a stand-alone application from the
program group In-Situ Inc., or accessed from Win-Situ’s Tools menu when
both are installed on the same system.
Input
In the Fixed Correction and Manual Entry options, it is important to know
the barometric pressure for the general time period covered by the log or
logs you want to correct.
Baro Merge uses a Wizard-like interface consisting of three main steps:
1. First, choose the type of compensation/correction you wish to use
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2. Then, choose the absolute (non-vented) log file or files you wish to
correct. Baro Merge displays these automatically
3. Click OK and the barometric compensation is applied
Output
Your original log file is not changed. A new, corrected log file with the same
name and path is created. The original “.wsl” extension is replaced by
“-BaroMerge.wsl”.
For help on using Win-Situ Baro Merge, press F1 at any Baro Merge
screen.
For more detailed information on barometric compensation, see the
technical notes on the In-Situ software/resource CD, or www.in-situ.com.
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7 Field Installation
Do not let the
instrument free
fall into the
water as this may create
a “water hammer” effect
and damage the pressure
sensor.

Positioning the Vented Aqua TROLL 200
For unattended deployment, lower the Aqua TROLL 200 instrument
gently to approximately the desired depth. Position the instrument below
the lowest anticipated water level, but not so low that its range might be
exceeded at the highest anticipated level. Refer to the tables below for
usable depth.
Check the Instrument’s Depth
At this point, if convenient, you can connect the Aqua TROLL 200 to a
PC, launch the software, and take a reading. If the instrument is at the

Vented Aqua TROLL
Range

Non-Vented Aqua TROLL

Usable Depth

Range

Effective Range*

psig

kPa

Meters

Feet

psia		

psia

5
15
30
100
300
500

34.5
103.4
206.8
689.5
2068
3447

0-3.5
0-11
0-21
0-70
0-210
0-351

0-11.5
0-35
0-69
0-231
0-692
0-1153

30
100
300
500

15.5
85.5
285.5
485.5

Usable Depth

kPa

Meters

Feet

106.9
589.5
1968
3347

0-10.9
0-60.1
0-200.7
0-341.3

0-35.8
0-197.3
0-658.7
0-1120

* At sea level (14.5 psi atmospheric pressure).
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desired depth, secure it in position as suggested below, or
reposition as necessary.
If you requested the software to “Remind me later” to set a Level
Reference, enter the level reference after installation when
prompted.
Secure the Cable
The RuggedCable® has a handy device called a Kellems® grip
near the surface end. You can slide it along the cable to the
desired position by compressing it. When you pull on it, it tightens
and stops sliding. You may need to pull on both ends of the
Kellems grip to properly tighten it and keep it from slipping.
Use the loop of the Kellems grip to anchor the cable to a
convenient stationary object. It works well with In-Situ’s “well dock”
installation ring. Simply insert the loop into the locking clip on the
well dock, and position the assembly on the top of a well.
Installation Tips
 Never let a probe “free fall” down a well. The resulting shock
wave when it hits the water surface can damage the strain
gauge (the “waterhammer” effect).
Kellems grip

 It is always wise to check the level of water above the probe,
then move it and read again to be sure that the probe is
giving a reasonable reading and showing change. It might
not be located where you think it is — for example, it could be
wedged against the casing with a loop of cable hanging below
it. A probe in such a position might become dislodged and
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The minimum
bend radius for
vented cable is
13.5 mm (0.54 in).

Do not
submerge
the cable
connector; do not immerse
in any fluid.

TIP: Be sure
to replace the
desiccant when
it appears pink. Expired
desiccant can allow
water build up in the vent
tube, causing a blockage
resulting in inaccurate data.
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move while logging, giving a false change in level. A secure placement
is critical to accurate measurements.
 Do not allow the vented cable to kink or bend. If the internal vent tube
is obstructed, water level measurements can be adversely affected.
The recommended minimum bend radius is 13.5 mm (0.54 in), which
is twice the cable diameter.
 For accurate measurements, the instrument should remain immobile
while logging data.
 Be sure the “uphole” cable end is capped—desiccant on the vented
cable connector, soft dust cap on non-vented cable—and positioned
above the highest anticipated water level. Avoid areas that may flood
when using vented cable.
Stabilization Time
Allow the Aqua TROLL instrument to stabilize to the water conditions for
about an hour before logging data. A generous stabilization time is always
desirable, especially in long-term deployments. Even though the cable is
shielded, temperature stabilization, stretching, and unkinking can cause
apparent changes in the level reading. A completely dry conductivity
sensor may need a few minutes settling time after initial immersion. If
you expect to monitor conductivity and water levels to the accuracy of the
probe, allow time for the probe to stabilize to its environment.
Shallow Deployment
When deploying the Aqua TROLL instrument in shallow water, bubble
formation on the conductivity sensor can create false readings. We
recommend the following to minimize the formation of bubbles:
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 Surface Water: Gently agitate the instrument. Natural water flow will
help to prevent bubbles.
 Groundwater Well, or any location without flowing water or where the
instrument cannot be seen:
1. Lower the Aqua TROLL instrument until it is below the surface of
the water. (Tip: This can be determined if not visible by monitoring
the pressure/depth readings.)
2. Allow the conductivity sensor to be thoroughly wetted (at least 30
seconds).
3. Briskly agitate up and down several times, while not taking the
device above the water surface.
4. When the conductivity readings stabilize, the Aqua TROLL is
ready for deployment.
TIP: Be sure
to program a
non-vented Aqua
TROLL before attaching
the Twist-Lock hanger,
as this accessory has no
communication capability.

DO NOT
submerge a
non-vented
Aqua TROLL without first
attaching a Twist-Lock
hanger, or a cable, as the
unit could be damaged by
flooding.

Installation of a Non-Vented Aqua TROLL
Aqua TROLL 100 and non-vented Aqua TROLL 200 instruments
do not require vented cable for proper operation. They may be
deployed on non-vented RuggedCable or with a Twist-Lock Hanger
and stainless steel suspension wire.
•

Because the Twist-Lock Hanger has no communication
capabilities, program the Aqua TROLL in advance, and
download the data the same way

•

Logged pressure data will show the effects of changes in
barometric pressure (unlike vented Aqua TROLL 200 sensors).
However, post-processing tools such as Win-Situ Baro Merge
may be used to eliminate the effects of barometric pressure
changes from the data, if required.
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8 Analog, SDI-12 and
Modbus connections
The Aqua TROLL instrument may be connected to a controller or logger
for communication via:
•
•
•
•

Analog (4-20 mA) provides a configurable 4-20 mA current loop
output
SDI-12
RS485 Modbus
RS232 Modbus (with a customer-supplied converter)

RuggedCable Stripped & Tinned has a “female” Twist-Lock connector on
one end to mate with the Aqua TROLL body. The uphole end terminates in
bare wires for connection to a PLC or data logger.
Also available in a shorter length ending in a “male” Twist-Lock connector
to mate with RuggedCable.
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PLC or Logger

Stripped & Tinned Cable
with “female” connector
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PLC or Logger

Short Stripped & Tinned Cable
with “male” connector

RuggedCable

Aqua TROLL
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Desiccant
Vented cable includes removable
outboard desiccant to protect the cable
vent tube and Aqua TROLL electronics
from condensation in high-humidity
environments.
The desiccant may be removed from the
vent tube, if needed, to trim the conductor
wires. Pull the vent tube extender off
the cable vent tube to remove, replace
desiccant after trimming and connecting
the wires.

Outboard desiccant
is attached to cable
vent tube

and secured
to cable with
strap

Wiring
Refer to diagrams on the following pages. Trim back and insulate unused
wires. The shield should be wired to a chassis ground or earth ground.

RuggedCable (TPU)
Signal

Color

Gnd/Return
Ext Power
4-20 mA
RS485(–)
RS485(+)
SDI-12

BLACK
RED
BROWN
GREEN
BLUE
WHITE
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Tefzel Cable

Pin
6
5
4
3
2
1

m1
f6

m2

f5

m3
f4

Signal

Color

Gnd/Return
Ext Power
4-20 mA
RS485(–)
RS485(+)
SDI-12

BLACK
RED
BROWN
GREEN
ORANGE
YELLOW
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3 wire

PLC or Data Logger
ext pwr red

+
-

12-36 VDC
signal

4-20 ma brown
gnd/return black

Aqua
TROLL
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3 wire

Data Logger
9.6-16 VDC

sdi-12 white*
ext pwr red
gnd/return black
rs485 (–) green
rs485 (+) blue**

* Yellow for Tefzel cable
** Orange for Tefzel cable
Max. cable length 200 ft

SDI-12
sensor
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Modbus Master
with RS485 built in
Digital PLC
12-36 VDC*

ext pwr red
gnd/return black
rs485 (–) green
rs485 (+) blue**

* Optional but highly recommended
** Orange for Tefzel cable

Modbus
Slave
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Modbus Master
with RS232 built in (converter required)
Digital PLC
ext pwr red
12 VDC*

gnd/return black
Gnd +12V

rs232 (TXD)

rs485 (–) green
rs485 (+) blue**

rs232 (RXD)
Converter

* Voltage limited by converter
** Orange for Tefzel cable
ext pwr red***

Converter

RS485

DB9F

gnd/return black***
rs485 (+) blue**
rs485 (–) green

TD(A)
TD(B)
GND
GND
+12V

5 gnd
pin 3 txd
pin 2 rxd
pin

RS232

Port-powered RS485 converter,
such as B&B Electronics Model
485SD9TB

Modbus
Slave

***Required if port power is not available
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Power Connections
The Red wire provides power for all Aqua TROLL modes. Analog output
is disabled by default. However, the 4-20 mA current loop output can be
continuous in Modbus or SDI-12 mode as long as Modbus device register
49507 is set to 1. This can be done with a connection in Win-Situ by
selecting the Device Setup tab, Analog Setup button, and enabling analog
output.
Communications
The device automatically switches between Modbus and SDI-12 modes
depending on which of the two interfaces has activity. Modbus and SDI-12
cannot be used at the same time — whichever one is currently in use will
block communication on the other.
Using Win-Situ Software
Win-Situ provides options for configuring analog/SDI-12 communications
(Setup tab) and Modbus communications (File menu > Settings). In
addition, the Aqua TROLL is capable of internal logging (programmed
in Win-Situ) while participating in a Modbus, SDI-12, or analog network.
However, Win-Situ cannot communicate with the Aqua TROLL while
it is transmitting Modbus, SDI-12, or analog data, and conversely, the
instrument cannot receive or respond to Modbus, SDI-12, or analog
commands while connected to a PC serial port.
This “redundant logging” feature means:
•

If the PLC or recorder somehow “loses” data, the Aqua TROLL data
can be retrieved using Win-Situ.
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If the PLC or recorder ceases to function due to power loss, the Aqua
TROLL will continue to collect data using its own internal batteries and
clock.

A port-powered RS485 converter like that shown for Modbus connections
may be used for temporary connection of the Aqua TROLL to a serial port
on a PC.
For More Information
For additional information on Modbus and SDI-12 communications,
including the SDI-12 commands and Modbus registers, see these In-Situ
technical notes:
•
•

SDI-12 Commands and Aqua TROLL Responses. November 2006.
In-Situ Modbus Communication Protocol. Bill Bonner, Senior
Software Engineer, In-Situ Inc., version 6, January 2007.

They are available on the In-Situ software/resource CD and at www.
in-situ.com.
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9 Care & Maintenance
Operating Considerations
The Aqua TROLL instrument has been designed to withstand harsh
field conditions. However, as with any electronic instrument, it can be
permanently damaged if used outside its operating specifications.
Temperature
The Aqua TROLL temperature sensor operates within a temperature
range of -20° to +65°C (-4° to +149°F).
Pressure Range
The Aqua TROLL 200 can withstand pressures of up to two times (2X) the
rated range of the pressure sensor without damage, although it may not
read correctly at such pressure. If the pressure range is exceeded by 3X,
the pressure sensor will be destroyed.
Factory Calibration
Accuracy can be adversely affected by improper care and handling,
lightning strikes and similar surges, exceeding operating temperature
and pressure limits, physical damage or abuse. Factory calibration every
12-18 months is recommended. Contact In-Situ Customer Service for
information on the factory maintenance and calibration plan.
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Storage
Store the Aqua TROLL instrument clean and dry. Place the protective
red dust cap on the cable end, or store with cable attached to protect the
connector pins and o-ring.
Store the instrument where it will be safe from mechanical shocks, such
as may occur if it rolls off a bench onto a hard surface.
Protect the instrument from temperature extremes. Store within a
temperature range of -40°C to +65°C (-40°F to +149°F).
Do not
submerge
the cable
connector; do not immerse
in any fluid.

General Maintenance

TIP: Be sure
to replace the
desiccant when
it appears pink. Expired
desiccant can allow
water build up in the vent
tube, causing a blockage
resulting in inaccurate data.

Cable Vent Tube (Vented Cable)

The minimum
bend radius for
vented cable is
13.5 mm (0.54 in).

Twist-Lock Connectors
Keep the pins on all connectors free of dirt and moisture by using the soft
protective dust cap when cable is not attached.
Vented cable assures that atmospheric pressure is the reference pressure
to the vented pressure sensor diaphragm. The vent tube should not be
blocked, kinked, or otherwise obstructed. Such obstructions will cause
barometric pressure to appear in measurements, and errors will be
introduced due to thermal expansion and contraction of air within the vent
tube and probe body.
The recommended minimum bend radius is
13.5 mm (0.54 in), which is twice the cable
diameter.
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TIP: If batteries
are completely
exhausted,
remember that external
power and battery pack
options are available.
When the nose
cone is removed
from the Aqua
TROLL 200, the sensitive
pressure sensor diaphragm
is completely exposed. Do
not touch this area with any
object! Replace the nose
cone as soon as possible.

Aqua TROLL 200
front end with nose
cone in place
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Batteries
Internal batteries in the Aqua TROLL are not user-replaceable. The
approximate percentage remaining is displayed on the software’s
Dashboard when the Aqua TROLL is connected.
Cleaning
Body and Front End
Clean the Aqua TROLL body with water and a soft brush or plastic
scouring pad, or soak overnight in a mild acidic solution, such as
household vinegar.
If the pressure ports of the Aqua TROLL 200 in the front end are clogged
with silt or mud, try the following:
•
•
•

Swish the instrument vigorously in a bucket of clean water
Apply a gentle squeeze of water from a wash bottle
In severe cases, remove the nose cone and clean out the holes with a
soft brush or pipe cleaner
Damage caused by digging or scraping in the pressure sensor
opening to remove silt, mud, etc. is not covered by the warranty.

To avoid damage to the pressure sensor diaphragm, do not insert any
object into the sensor opening or attempt to dig out dirt or other materials.

Nose cone removed
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Conductivity Sensor
Fouling from mineral and biological sources can alter the sensor’s response.
 Always begin with a rinse under running water to remove loose
material.
 Always finish with a rinse in clean water.
 After cleaning, always check the calibration before redeployment, and
recalibrate the sensor when necessary.
Acceptable cleaning processes fall into the following categories:
TIP: Foam swabs
are shipped with
the Aqua TROLL;
replacements are available
from In-Situ Inc. (Catalog
No. 0056820).

TIP: Alconox® is
available from InSitu Inc. (Catalog
No. 0029810).

DO NOT SOAK
in phosphoric
acid or LimeA-Way® for more than 10
minutes.

Process 1: Light scrubbing with a soft swab and mild soap such as a
dilute solution of dish detergent. Be careful not
to damage the plastic material of the conductivity
cell. Aqua TROLL instruments are shipped with
polyurethane foam swabs for this purpose. We have
also seen good results using a gentle back-and-forth
“flossing” motion with a thin cotton pipe cleaner.
Process 2: Light scrubbing with a foam swab and an
aggressive soap such as Alconox® detergent can be
used for more stubborn deposits.
Process 3: Dilute (10:1) acetic acid, or consumer-packaged white vinegar,
can be used to pre-soften calcium deposits. Follow this with Process 1
or Process 2, depending on the degree of residual contamination. The
Aqua TROLL can soak for any length of time in dilute acetic acid. If
this does not completely remove the material, try Process 4.
Process 4: Dilute phosphoric acid (< 27%) or the consumer product
Lime-A-Way® can be topically applied with a soft swab to remove iron
or calcium deposits that remain after using Process 3. Do not soak for
more than 10 minutes. Rinse well with water.
If contamination cannot be removed using the recommendations above,
please contact In-Situ Inc. as described on page 10.
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10 Troubleshooting
Troubleshooting Connections
Problem: Win-Situ cannot connect to the Aqua TROLL instrument.
Probable Cause: Wrong COM port selected, incompatible
Communication settings, loose or dirty cable connections, low
batteries
Suggested Remedy: Check the following:
•
•
•
•

•

All cable connections are tight, connectors are clean and dry.
The cable is securely attached to the instrument.
The correct COM port is selected (select Preferences menu >
Comm Settings to check this).
The communication settings in Win-Situ and in the Aqua TROLL
match. To reset the device communication settings to the serial
defaults, click “Reset all Devices” in the Comm Settings dialog
(Preferences menu > Comm Settings)
The internal battery has voltage remaining or external power is
supplied.
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Problem: Real-time readings are in the wrong units.
Probable Cause: Default units are being used.
Suggested Remedy: Click the Sensors tab, select the sensor, click the
“Configure” button

, and select the desired units for each

parameter in the Sensor Setup window. Click OK
stop “polling” in the Home screen before selecting units.

. Be sure to

Troubleshooting Data Logs
Problem: Cannot add a new log
Probable Cause 1: Only one “active” log can reside in the device at a
time—an “active” log is a log that is Ready, Pending, Running, or
Suspended as shown in the Status column of the Logging Tab
Suggested Remedy: Stop or delete the log if possible. Alternatively,
configure the new log after the active log is completed.
Probable Cause 2: The device has its maximum number of logs already
stored—although this is not a likely cause for the Aqua TROLL 200,
which has a capacity of 50 logs.
Suggested Remedy: Download, and then delete a log you are through
with. This will make room for an additional log on the device.
Problem: New log exceeds available memory (message from software).
Probable Cause: The log as configured would exceed the device memory.
Suggested Remedy: Edit the log and try these:
• Select a longer sampling interval .
• If available, select the “Wrap data” option (later data will
overwrite earlier data when the memory is full).
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For a log with a scheduled start, select “None” as the stop
condition, or select a stop time that is closer to the start time.
You may intend to stop the log before the scheduled end date
arrives, but the software doesn’t know that.

Troubleshooting Parameter Configuration
Problem: Cannot configure level or other parameters using the Configure
button on the Sensors tab. The Sensor setup screen is shown, but the
Configure... button is dimmed out.
Probable Cause 1: The Aqua TROLL is actively “polling” (continually
updating real-time readings) in the Home tab.
Suggested Remedy: Return to the Home tab and stop real-time readings
by clicking
Probable Cause 2: The Aqua TROLL has an “active” log—a log that
is Ready, Pending, Running, or Suspended as shown in the Status
column of the Logging Tab. Only one “active” log can reside in the
device at a time.
Suggested Remedy: Stop or delete the log if possible. Alternatively,
configure parameters after the log is completed.
Troubleshooting Conductivity Calibration
Problem: The calculated cell constant (Kcell) is lower than the
recommended range of 0.98 – 1.02.
Probable Cause: The electrical resistance of the calibration solution was
lower than expected for the nominal value.
Suggested Remedy: Check the following and then repeat the calibration:
• Visually inspect the sensor for the presence of fouling (most
likely conductive material, possibly a bio-film); clean as
described in Section 9 of this manual.
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Ensure the calibration solution is not contaminated, mislabeled,
or partially evaporated.
Rinse the Aqua TROLL and the Cal Cup thoroughly with fresh
calibration solution before calibrating.

Problem: The calculated cell constant (Kcell) is higher than the
recommended range of 0.98 – 1.02.
Probable Cause: The electrical resistance of the calibration solution
was higher than expected for the nominal value, or an air bubble was
present in the sensing cell during calibration.
Suggested Remedy: Check the following and then repeat the calibration:
• Visually inspect the sensor for the presence of fouling (most
likely an obstructing material or organism); clean as described in
Section 9 of this manual.
• Ensure the calibration solution is not contaminated, mislabeled,
or partially diluted.
• Rinse the Aqua TROLL and the Cal Cup thoroughly with fresh
calibration solution before calibrating.
• “Roll and tap” the Aqua TROLL in the Cal Cup to dispel air
bubbles as described and illustrated in Section 5.

Aqua TROLL Operator’s Manual

0061340 rev. 003

88

Index
A
AC adapter, 19
Accessories, 20
Active log, 44, 85, 86
ActiveSync, 21
Analog (4-20 mA) output
enabling, 78
wiring, 74

B
Barometric pressure compensation, 65–66
Batteries, external, 19
Batteries, internal, 19, 82

C
Cable, 14
bend radius, 69, 81
communication cables, 18
Kellems grip, 68
non-vented cable, 70
stripped & tinned, 16, 71, 72
suspension wire, 14, 16, 70

TROLL Com, 46
vented cable, 58, 69, 81
Calibration
conductivity, 42, 48, 86–87
nominal stability, 54
pressure sensor, 63
Cell constant, 48, 53, 54, 86–87
Cleaning, 57, 82
conductivity sensor, 83
decontamination, 12
Clock
displaying
Clock, setting, 37
Conductivity, 47–57
about, 47
actual, 55
available parameters, 55
calibration, 42, 48, 86–87
shallow deployment, 56, 69
specific, 55
Conductivity sensor, 42, 48
cleaning, 83
Continuous button (Profiler)

D
Data
graphing, 45
logging, 43
viewing, 45
Decimal places displayed in Home
screen, 36
Declaration of Conformity, 91
Density, 59
Depth, measuring, 59
Desiccant, 17, 46, 69, 81
outboard, 73

F
Factory recalibration, 63

H
Hanger, twist-lock, 20, 70
Home tab (Win-Situ), 35
customizing, 36

I
Installation, 67–69

iNDEX
accessories for, 20
in shallow water, 56, 69
non-vented, 70
software, 28

L
Level, measuring, 59
Local gravitational factor, 59
Log, active, 44, 85, 86
Logging data
downloading, 45
redundant logging, 78–79
setting up, 43
starting to log, 45
Logging tab (Win-Situ), 43

M
Maintenance, 81–83
Maintenance & calibration
service, 10, 63
Microsoft ActiveSync, 21
Modbus
communication, 78
power, 78
registers, 79
wiring, 76, 77

N
Nominal stability, 54
Non-vented Aqua TROLL, 44, 70
data correction, 65–66
Nose cone, 50, 82
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P
Polling, 35
Poll rate, changing, 36
Pressure, measuring, 59
Pressure range, 80
usable depth, 24, 67
Pressure sensor
absolute vs. gauged, 58
calibration, 63
do not touch!, 50, 82
non-vented vs. vented, 58
zeroing, 63–64
Product specifications, 22
Profiling, 35
psia, 58
psig, 58

R

wiring, 75
Sensors tab (Win-Situ), 60, 64
Serial number, 8
Site, 38
Specifications, 22
Specific conductivity, 55
Specific gravity, 59
Storage, 81

T
TDS, 56
Temperature range, 80
Thermal stabilization, 69
Time, setting, 37
Total Dissolved Solids, 56
TROLL Com
removing, 46
Troubleshooting, 84–87

Real-time readings, 35
units, 36
update rate, 36
Repair service, 11
Reset communications, 84
Resistivity, 56
RMA, 11

U

S

W

Salinity, 55
SDI-12
commands, 79
communication, 78
power, 78

Warranty, 10
Win-Situ, 21
BaroMerge, 65–66
Control Panel, 35
Dashboard, 35

Units, 36, 85

V
Vented cable, 58
bend radius, 69, 81
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exiting, 46
installing, 28
logging data, 43
redundant logging, 78–79
site, 38
Software Manager, 28
system requirements, 21
tabs, 35
Win-Situ Mobile, 21, 28
Wiring
analog (4-20 mA), 74
Modbus RS232, 77
Modbus RS485, 76
SDI-12, 75
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Declaration of Conformity
Manufacturer:

In-Situ, Inc.
221 East Lincoln Avenue
Fort Collins, CO 80524
USA

Declares that the following product:
Product name:
Model:
Product Description:

Aqua TROLL
Aqua TROLL 200
The Aqua TROLL 200 measures and logs level, temperature, and conductivity in
natural groundwater and surface water.

is in compliance with the following Directives:
89/336/EEC for Electromagnetic Compatibility (EMC) Directive
73/23/EEC for Safety Directive
and meets or exceeds the following international requirements and compliance standards:
•

Immunity
EN 61326:1997, Electric Equipment for Measurement, Control and Laboratory Use

•

Emissions
Class A requirements of EN 61326:1997, Electric Equipment for Measurement, Control
and Laboratory Use

Supplementary Information:
The device complies with the requirements of the EU Directives 89/336/EEC and 73/23/EEC, and the CE
mark is affixed accordingly.

Todd Campbell
New Product Development Program Manager
In-Situ, Inc.
October 17, 2006

Declaration of Conformity
Manufacturer:

In-Situ, Inc.
221 East Lincoln Avenue
Fort Collins, CO 80524
USA

Declares that the following product:
Product name:
Model:
Product Description:

Aqua TROLL
Aqua TROLL 100
The Aqua TROLL 100 measures and logs temperature and conductivity in
natural groundwater and surface water.

is in compliance with the following Directives:
89/336/EEC for Electromagnetic Compatibility (EMC) Directive
73/23/EEC for Safety Directive
and meets or exceeds the following international requirements and compliance standards:
Immunity
EN 61326:1997, Electric Equipment for Measurement, Control and Laboratory Use
Emissions
Class A requirements of EN 61326:1997, Electric Equipment for Measurement, Control
and Laboratory Use
Supplementary Information:
The device complies with the requirements of the EU Directives 89/336/EEC and 73/23/EEC, and the CE
mark is affixed accordingly.

Bob Blythe
President and CEO
In-Situ Inc.
September 5, 2008

Declaration of Conformity
Manufacturer:

In-Situ, Inc.
221 East Lincoln Avenue
Fort Collins, CO 80524
USA

Declares that the following product:
Product name:
Model:
Product Description:

TROLL Com
USB TROLL Com
RS485 to USB converter

is in compliance with the following Directive
89/336/EEC for Electromagnetic Compatibility (EMC) Directive
73/23/EEC for Safety Directive
and meets or exceeds the following international requirements and compliance standards:
•

Immunity
EN 61326, Electrical Equipment for Measurement, Control and Laboratory Use, Industrial
Location

•

Emissions
Class A requirements of EN 61326, Electrical Equipment for Measurement, Control and
Laboratory Use

Supplementary Information:
The device complies with the requirements of the EU Directives 89/336/EEC and 73/23/EEC, and the CE
mark is affixed accordingly.

Todd Campbell
New Product Development Program Manager
In-Situ, Inc.
June 17, 2006

